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General License
Agreement

Attention: this is a license, not a sale. This product is provided under the
following license which defines what you may do with the product and
contains limitations on warranties and/or remedies.

LICENSE AGREEMENT

IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE
USING THIS PRODUCT. INSTALLING, COPYING, OR
OTHERWISE USING THIS PRODUCT INDICATES YOUR
ACKNOWLEDGMENT THAT YOU HAVE READ THIS LICENSE
AND AGREE TO BE BOUND BY AND COMPLY WITH ITS
TERMS. IF YOU DO NOT AGREE, RETURN THE COMPLETE
PRODUCT TO ALCHEMY SOFTWARE DEVELOPMENT LIMITED,
HARCOURT BUSINESS CENTRE, HARCOURT STREET, DUBLIN
2, IRELAND, WITHIN 10 DAYS OF THE DATE YOU ACQUIRED
IT FOR A FULL REFUND. THIS LICENSE AGREEMENT IS YOUR
PROOF OF LICENSE. PLEASE TREAT IT AS VALUABLE
PROPERTY.

A. LICENSE:

ALCHEMY SOFTWARE DEVELOPMENT LIMITED ("ALCHEMY",
"we" or "us") provides you with storage media containing a computer
program, computer software, including its code, objects including their
API's as well as any images, photographs, templates, animations, video,
audio, music, text and "applets" incorporated into the software, the
accompanying printed materials, a License, and "online" or electronic
documentation (together called the "Product") and we grant you a license
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to use the Product in accordance with the terms of this License. Any
supplemental software code and supporting materials provided to you as
part of support services provided by ALCHEMY for the Product shall be
considered part of the Product and subject to the terms and conditions of
this License. The copyright and all other rights to the Product shall
remain with us or our licensors. You must reproduce any copyright or
other notice marked on the Product on all copies you make.

B. YOU MAY:

1. Install and use one copy of the Product on a single computer.

2. You may also store or install a copy of the Product on a storage
device, such as a network server, used only to install or run the Product
on your other computers over an internal network; however, you must
acquire and dedicate a license for each separate computer on which the
Product is installed or run from the storage device.

3. Make one copy of the Product for archive or backup purposes.

4. Transfer the Product to someone else only if you assign all of your
rights under this License, cease all use of the Product, erase or destroy
any copy (including the hard disk copy) made in support of your use of
the Product, and ensure that the person to whom you wish to transfer the
Product agrees to the terms of this License.

5. If this Product contains the CATALYST Software Developer's Kit
("SDK"), you may use the SDK and any sample files included only as
outlined in the SDK Addendum to this General License Agreement.

C.YOU MAY NOT:

1. Use the Product or make copies of it except as permitted in this
License.

2. Translate, reverse engineer, decompile, or disassemble the Product
except to the extent the foregoing restriction is expressly prohibited by
applicable law.

3. Rent, lease, assign, or transfer the Product except as set out in
paragraph B above.

4. Modify the Product or merge all or any part of the Product with
another program.

5. Separate the component parts of the Product for use on more than one
computer.
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D. TERM:

This license shall remain in effect only for so long as you are in
compliance with the terms and conditions of this agreement. This license
will terminate if you fail to comply with any of its terms or conditions.
You agree, upon termination, to destroy all copies of the Product. The
Limitations of Warranties and Liability set out below shall continue in
force even after any termination.

E. WARRANTY:

WE WARRANT THAT THE STORAGE MEDIA IN THIS PRODUCT
WILL BE FREE FROM DEFECT IN MATERIALS AND
WORKMANSHIP FOR NINETY (90) DAYS FROM THE DATE YOU
ACQUIRE IT. IF SUCH A DEFECT OCCURS, RETURN THE
MEDIA TO US AT, ALCHEMY SOFTWARE DEVELOPMENT
LIMITED, HARCOURT BUSINESS CENTRE, HARCOURT
STREET, DUBLIN 2, IRELAND, AND WE WILL REPLACE IT
FREE OF CHARGE. THIS REMEDY IS YOUR EXCLUSIVE
REMEDY FOR BREACH OF THIS WARRANTY. IT GIVES YOU
CERTAIN RIGHTS AND YOU MAY HAVE OTHER LEGISLATED
RIGHTS WHICH MAY VARY FROM JURISDICTION TO
JURISDICTION.

F. LIMITATION OF WARRANTIES AND
LIABILITY:

EXCEPT FOR THE EXPRESS WARRANTY ABOVE , THE
PRODUCT IS PROVIDED ON AN "AS IS" BASIS, WITHOUT ANY
OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF
MERCHANTABLE QUALITY, SATISFACTORY QUALITY,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF
TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE
RISK AS TO THE RESULTS AND PERFORMANCE OF THE
PRODUCT IS ASSUMED BY YOU. NEITHER WE NOR OUR
DEALERS OR SUPPLIERS SHALL HAVE ANY LIABILITY TO
YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT,
INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES
WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF
REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER
COMMERCIAL OR ECONOMIC LOSS, EVEN IF WE HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY
ARE FORESEEABLE. WE ARE ALSO NOT RESPONSIBLE FOR
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CLAIMS BY A THIRD PARTY. OUR MAXIMUM AGGREGATE
LIABILITY TO YOU AND THAT OF OUR DEALERS AND
SUPPLIERS SHALL NOT EXCEED THE AMOUNT PAID BY YOU
FOR THE PRODUCT. THE LIMITATIONS IN THIS SECTION
SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR
DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR
TERM OR A FUNDAMENTAL BREACH. SOME
STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY
NOT APPLY TO YOU.

G. U.S. Government Rights:

With respect to any acquisition of the Software or Software product by
or for any unit or agency of the United States Government (the
"Government"), the Software or Software product shall be classified as
"commercial computer software", as that term is defined in the
applicable provisions of the Federal Acquisition Regulation (the "FAR")
and supplements thereto, including the Department of Defense (dod)
FAR Supplement (the "DFARS"). The Software or Software product was
developed entirely at private expense, and no part of the Software or
Software product was first produced in the performance of a
Government contract. If the Software or Software product is supplied for
use by dod, the Software or Software product is delivered subject to the
terms of this Agreement and either (i) in accordance with DFARS
227.7202-1(a) and 227.7202-3(a), or (ii) with restricted rights in
accordance with DFARS 252-227-7013 (c)(1)(ii))(OCT 1988), as
applicable. If the Software or Software product is supplied for use by a
Federal agency other than dod, the Software or Software product is
restricted computer software delivered subject to the terms of this
Agreement and (i) FAR 12.212(a); (ii)) FAR 52.227-19; or (iii) FAR
52.227-14(ALT 1), as applicable. The contractor/manufacturer is
Alchemy Software Development Limited, Harcourt Business Centre,
Harcourt Street, Dublin 2, Ireland.

H. GENERAL:

This License is the entire agreement between us, superseding any other
agreement or discussions, oral or written, and may not be changed except
by a signed agreement. This License shall be governed by and construed
in accordance with the laws of the Republic of Ireland. If any provision
of this License is declared by a Court of competent jurisdiction to be
invalid, illegal, or unenforceable, such a provision shall be severed from
the License and the other provisions shall remain in full force and effect.
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SDK Addendum To The General License Agreement

IF THIS PRODUCT CONTAINS AN ALCHEMY SOFTWARE
DEVELOPER'S TOOLKIT ("SDK"), YOUR USE OF THE SDK
PORTION OF THE PRODUCT IS GOVERNED BY THE TERMS OF
THE GENERAL LICENSE AGREEMENT AS MODIFIED BY THE
TERMS OF THIS SDK ADDENDUM TO THE GENERAL LICENSE
AGREEMENT. IN THE EVENT OF ANY CONFLICT BETWEEN
THE TERMS OF THE GENERAL LICENSE AGREEMENT AND
THIS SDK ADDENDUM, THE TERMS OF THIS SDK ADDENDUM
TO THE GENERAL LICENSE AGREEMENT SHALL GOVERN.

It is Alchemy's intention in designing the Software Developer's Kit to
make it compatible with other versions of the Software Developer's Kit.
However, since it is constantly being modified and reorganized, with
certain capabilities added to or eliminated from any particular version or
product, Alchemy makes no representations or warranties concerning
compatibility with other versions or products.

You are solely responsible for determining the usefulness of the
Software Developer's Kit for your particular purpose. The Software
Developer's Kit is provided to software developers with the expectation
that the developers are capable of writing and debugging their own
programs; Alchemy does not assume any support obligations with
respect to the Software Developer's Kit or the use thereof. Any research,
development, or evaluations you perform is done entirely at your own
risk.

YOU MAY:

1. Use the SDK solely for the purpose of developing, manufacturing,
marketing and supporting one or more applications software package(s)
("Software Application Product").

2. Develop an editor that may be used by you only in conjunction with
the Product.

YOU MAY NOT:

1. Remove or alter any copyright notice, trademark, or other proprietary
rights notice placed by Alchemy on the SDK or any portion thereof.

2. Reproduce and sublicense the software program files included in the
SDK's ‘Samples' folder ("SDK files"), provided the files are in
executable format and incorporated into a Software Application Product
developed by you. Any sublicense of the SDK files shall be granted
solely for the use of these SDK files in connection with and as a
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sublicensed part of a Software Application Product for any support,
service, upgrades or other assistance.

INDEMNIFICATION:

You agree to indemnify and hold Alchemy harmless from and against
any and all costs, liabilities, claims, or demands (including reasonable
attorney's fees and expenses of any kind whatsoever) that arise or result
from the use, reproduction or distribution of your Software Application
Product, documentation, or promotional or sales materials.

ALCHEMY TRADEMARKS AND TRADENAMES:

You may not refer to Alchemy or include any Alchemy trademarks in or
on any material except for the sole purpose of stating that a Software
Application Product may be utilized in connection with the specific
Alchemy software product. In the event you refer to Alchemy or include
the trademarks in or on any program materials or any packaging,
marketing, or advertising materials, the trade name or trademarks must
be accompanied with the following footnote disclaimer printed in a
clearly legible manner on the same page in no smaller than ten-point
type:

"This product is not manufactured, approved, or supported by Alchemy
Software Development Limited."



What’s new In
this release?

Alchemy CATALYST is enhanced in all areas to provide improvements
in languages supported, performance, productivity, usability, standards
support and greater functionality with Microsoft .NET technologies.

Alchemy CATALYST provides a truly visual environment for the
localization and engineering of digital content and all desktop, internet
and mobile applications. This section describes the most important
improvements and assumes you are already familiar with previous
versions of Alchemy CATALYST.

NEW Alchemy Desktop TM: This is ground breaking
translation memory technology with a host of new time-saving
features such as context matching, super—fast concordance
searching.

Enhanced PerfectMatch™ Translations: Reach new levels of
precision with automated recognition of context for segments
stored in your TM.

NEW Recycle Translation: Take precision to a higher level!
With Recycle Translation, your most recent translations are
propagated throughout your current project and presented as
translation suggestions in the Translator Toolbar. This improves
consistency and reduces your translation costs.

NEW Scheduler: Create automated workflows with the
innovative Scheduler. This allows you to work across several
languages simultaneously improving productivity and
efficiency.
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e NEW Performance Accelerators: Use the new accelerator
feature and extend the power of the Translator Toolbar by
adding web services. Simple to configure, yet powerful to use!

e NEW Multilingual Experts: Add increased velocity to your
localization process! All Alchemy Experts now work with the
Alchemy Scheduler making it easy to work with several
languages simultancously. A real productivity booster for
Project Managers and Engineers!

e NEW Embedded Systems: A new Size property has been
added to the meta-data for each segment. This property can
define segment size limitations and font information, based on
characters or pixel values. This makes it ideal for translating
mobile phones applications, embedded system software or even
in-car display units.

e NEW Alchemy SDK 9.0: Use the Software Development Kit to
extend the features of Alchemy CATALYST and fine-tune it for
your localization process. Include FREE with the
Developer/PRO edition, it brings a whole new dimension to the
word ‘customizable’.

e NEW Swap Languages: Create new source languages for your
translation projects using this new feature. It takes your target
language and converts it to the source language in a Project
TTK. This can then be used as a new source for subsequent
translations. Simple, yet powerful!

e NEW Quick Info: Ever want to know the wordcount or
translation analysis of a Project TTK in File Explorer. Now you
can, just hover over it with the mouse and it will reveal all!

e ENHANCED ezType™ Technology: ezType(TM) is
predictive text tailored for the professional translator. It now
intelligently scans your TM, Glossary and Machine Translated
material to present the best possible candidates for predictive
typing. An essential feature for improving productivity and
accuracy!

e NEW Analysis Expert: You asked, we delivered! Analyze the
number of segment matches, count unique and repetition words
and determine how many fuzzy matches can be re-used. The
Analysis Expert works with all industry standard TMs (.TM,
.TTK, .PPF, Alchemy Language Exchange, TRADOS TMW,
SDL TM Server, TMX, TXML, XLIFF, TXT) to determine how
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you can maximize the re-use of previous translations and reduce
your cost of translation further!

NEW Clean Up Expert: Consolidate multiple Project TTKs
into a single, highly portable desktop or server-based TM using
the Clean Up Expert. Now you can have a single TM containing
all your translations for your projects! How’s that for a neat
trick!

NEW Support for new file formats: A whole range of new file
formats have been added to address the growing need of our
clients who regularly work with a growing and diverse range of
formats. New formats now support are: Drivers (.sys), Control
Panel Apps (.cpl), ActiveX (.ocx), Multilingual Language Packs
(.mui), Codec files (.acm, .ax), Screen Savers (.scr), Borland
Library Files (.dpl, .bpl) and ZIP archives (.zip)

ENHANCED The Complete Microsoft .NET Solution:
Localize all variants of Microsoft .NET technologies within a
single, highly visual environment. Supporting all versions of
the Microsoft .NET framework, we’ve got you covered!

NEW Visual Editor for Microsoft WPF: Our WPF
Translation Editor now supports the display of standard and
custom widgets using a ground-breaking visual technology to
provide highly realistic rendering of even the most complex of
web based WPF applications.

NEW Comprehensive Online Help Solution: With support
for the new Microsoft Help 3.0 standard, now almost every
online help system can be localized, tested and engineered
within Alchemy CATALYST. And, as we promised, it’s all
done within WYSIWYG editors!

NEW Productivity Enhancements: Alchemy CATALYST 9.0
sees major changes in the user interface which drives more
productivity for translators, engineers and testers. As an
example, engineers can now visual navigate the contents of a
project using thumbnail images; translators can quickly
determine how consistent their translations are; translators can
now use ezType to accelerate the selection and translation of
source documents. Less engineering and testing is now required
for content files since these are all now worked-on in true-visual
editors.
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NEW Machine Translation: Experience the power of 2!
Combine the accuracy of TM with the flexibility and speed of
Machine Translation, all in a single highly interactive project
environment. Connectors available FREE with the product are
Google Translate and PROMT.

NEW Complete open standards support: Increased
compatibility, no matter what the format, including XLIFF,
TBX, XML, TMX, TXML and all TRADOS desktop and server
based TM technologies.
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Installation and
Activation

Due to piracy and other forms of unauthorized use, users cannot always
be sure that they have a genuine copy of Alchemy CATALYST. The
goal of product activation is to reduce a form of piracy known as casual
copying or "softlifting". We have worked to make it as easy as possible
to activate a licensed installation of Alchemy CATALYST.

Product Activation

For purposes of product activation only, a unique hardware identifier is
created from general information that is included in your operating
system components. At no time are files on the hard drive scanned, nor is
personally-identifiable information of any kind used to create the
hardware identifier.

If you are upgrading your license from a previously installed Alchemy
CATALYST license, the hardware identifier is used together with your
Dongle ID to create a unique installation ID. Whether you choose to
activate by using an Internet connection or by speaking with an Alchemy
customer service representative, the installation ID is the only piece of
information required to activate Alchemy CATALYST.

If you activate via an Internet connection, the Installation ID is sent
automatically using your default mail application. If an online
connection cannot be established, you are prompted to contact a
customer service representative by telephone. In that message, the
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installation ID is displayed to you. The customer service representative
will ask you to read the installation ID over the telephone.

Product Certificate

This installation ID is used to create a Product Certificate which is used
to activate a license of Alchemy CATALYST. This Product Certificate
is sent electronically via email. If you need to install Alchemy
CATALYST on a different computer using that Product Certificate, you
might need to contact an Alchemy customer service representative by
telephone to request another Product Certificate.

Until you have activated your copy of Alchemy CATALYST, you will
be prompted to do so each time you launch the application and an
Activate icon will appear in the Experts Toolbar.

Use the Activate Expert to configure Alchemy CATALYST as a 'stand-
alone' or 'metwork' license. The Activate Expert requests a Product
Certificate from Alchemy Software Development. This is used to
register your copy of Alchemy CATALYST and to authenticate your
license purchase.

If your installation of Alchemy CATALYST is not activated, it will run
in evaluation mode only and you will see the Activate Expert in your
Expert toolbar.

12



Installation and Activation

Activate Alchemy CATALYST

To launch the Activate CATALYST Expert, go to the Project
Navigator pane and click on Activate CATALYST. It will
automatically launch and display the following dialog:-

] Alchemy

—

Product
ACTIVATION

Alchemy proouct aCivaton was deveioped 1o help ensure that each Alchemy CATALYST keense i nstaled n cof
with the EULA and is not instalied 0n more than ene computer. We have worked fo make & as easy 85 possibie o 4
icenasd instalation of Alchemy CATAL'YST and this appleation was desigaed to tabe you threugh this activation p

The first step in Alchermy product activation is 19 request a Praduct Cedificale from Alchemy Software Develigs
Froduct Centificate is o digtally encrypled fis thal can be requested slectronicaly.
The secend step i to use your Product Cerificate 1o create o kcense fie which actvates Alchemy CATALYST.

Unti you have sctrvated your copy of Alchemy CATALYST, an Activale icon appears i the Experts Toolar. You 8
on the icon to intiate actication. This icon will not appear after you have activated Alchemy CATALYST,

Step1 Request s Product Certificate from Akhemy Softwane Development
Select this option W vou do not have a Product Certficate

There are two steps in the Alchemy CATALYST activation process:-
Step 1: Requesting a Product Certificate

Select Step 1 using the mouse to determine your
Installation ID and request a Product Certificate.

Step 1 Gathering Upgrade Information

Alchemy Catalyst will now scan your machine, creating and ingtalation 0 which wi
Product Certificate for your kicense. The Product Certificate will be sent via emai

Installation D 001320781da8 DISK_SERIAL_NUM={022bcSf

Step 2 Request Certificate
Emai Address v |Pease Type Emai Address?

ﬁm request a certificate for Alchemy Catalyst£.0 using your Mail Clent
OR
Eh request a certificate for Alchemy Catalyst 6.0 by copying the contes

T W ST gV FOT A A g,
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An installation ID will be created that uniquely
identifies your host computer. If you are upgrading
from a previously installed licensed version of
Alchemy CATALYST this ID will match your
previous installed version.

Step 2: Activating a License

Select Step 2 as you already have your Product
Certificate and you wish to activate your Alchemy
CATALYST license.

Use your Product Certificate to activate your Alchemy CATALYST license.

Step 1 Locate Product Certificate (*.cert)
Use the Browse button to select your Product Certificate

| Bro

Step 2 Activate your Product License

to activate your Product License

[T . s s e  rnt an,

Use the Browse button to locate your Product
Certificate and select the Click here button to
activate your Alchemy CATALYST license.

14



Understanding
the Basics

The following section is designed to be read by a new user of Alchemy
CATALYST and explains the basics of how the product works and some
of the technologies that are used in its design.

Segments

A Project TTK is made up of segments; the fundamental building block
of its database schema. A segment contains at least one source language
string and its equivalent target language translation.

A Project TTK is also a bi-lingual translation memory and can be used as
an Active TM in the Translator Toolbar. You can also store or Clean Up
several Project TTKs into a single multi-lingual Alchemy desktop
translation memory (a .TM file).

6 An Alchemy desktop TM is a multilingual file. A Project TTK
is bi-lingual. By using the Clean Up Expert, you can consolidate
many Project TTK files into a single multilingual desktop TM.
This improves the management of translation assets and leads to
higher re-use of translation across multiple file formats such as
online helps, Web sites and software applications.

Translating Segments

The Translator Toolbar is used to translate a segment. It allow you to
see all the details of a segment, including the extended information such

15
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as coordinates, style, IDs, max lengths etc. This extended information is

referred to trait information.
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# Description

1 Translated Text Window

Translations are entered into this window. Inline tags are displayed
graphically and can be moved or deleted using a combination of the
keyboard and mouse. Incorrect words are highlighted with a red
underline.

Source Text Window

This is the original source language text. This may contain red
over-lines that indicate that a word is available in the glossary and
is displayed in the Glossary Reference window (4).

If a translation memory suggestion is located and displayed in the
main Reference window (3) this window may contain colored
markups to distinguish text that has been added, moved or deleted.
This should be used in conjunction with the % Fuzzy Match figure
to determine how good a suggested translation is.

TM Reference Window

This window displays Translation Memory matches as well as
Machine Translation suggestions

Glossary Window

This window displays translation suggestions from glossary files.
You can also configure new glossary files by clicking Glossary
Source.

Segment Status

Each segment has a translation status indicator associated it. This is
maintained automatically by Alchemy CATALYST and can be used by

16
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professional translators to track the status of each segment as it
progresses through the translation workflow.

The status of each segment is displayed alongside it in the Project
Workspace pane. Additionally some of this status information is also
displayed alongside individual and group items in the Project Navigator
pane.

£ Logk For: ¥ | [0 Lockln: Fiter : Defa
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=0 2 A SR 3R Segment A
() For Review Items
= Y oK ok ¢
= untranslated items )
65535 The parsng nesforthis fle have changed  The parsin
from thoss in the XML Options page snce i thosa in the
& Ll was opened in Catalyst \n'nds a resut the openedin
file can be displayed in Developer mode, but displayed iré
Ny . 5 ntgg to madfﬂ;\w“m_“l:id only i

6 Use Filters to sort the contents of a Project TTK into different
lists based on translation status indicators.
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Translation Workflow

The status of a segment follows a defined three stage workflow. The
three states are: Untranslated, For Review and Signed Off.

Untranslated For Review Signed Off

No icon used & W'

For example, each segment is initially assigned the status of
Untranslated. It is then translated by a professional translator and
automatically assigned the status For Review. The segment is then
reviewed by a Senior Translator/Editor and assigned the status Signed
Off. This forms the basic translation workflow of Alchemy
CATALYST.

Using these three basic status indicators, it is easy for a translator to
filter his work based. For example, it is possible to open a project and
only view segments that are Untranslated or perhaps an Editor may
want to view only segments that have been translated and need to be
reviewed. In this scenario, the project would be filtered using the For
Review filter.

Other Translation Status Information

In addition to the basic three status indicators of a segment, there are
other status indicators that the Leverage Expert can assign which can
help professional translators track the progress of their work and how it
was re-used from a Translation Memory.

Translation Description

Status

Leveraged @ This is assigned by the Leverage Expert and

100% For indicates that a 100% match has been found

Review in a Translation Memory and that this
segment now needs to be reviewed by an
Editor.

Fuzzy @ This is assigned by the Leverage Expert and

Leveraged For indicates that a fuzzy match has been found

Review in a Translation Memory and that this
segment now needs to be reviewed by an
Editor.
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What is an Alchemy TM?

Alchemy uses a desktop translation memory based on XLIFF. This is an
industry standard file format designed for the efficient storage and
retrieval of translation assets. The Alchemy Translation Memory is used
to centrally store multiple CATALY ST TTKSs in a single file.

In the example below, an Alchemy TM is used as an Active TM and
translation suggestions are displayed for the translator for each segment.
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The Alchemy Translation Memory has a file extension of .TM and is a
completely self-contained file making it easy to create and distribute
throughout a translation team, and via email and workflow systems.
Additionally, since it is based on the XLIFF standard, it can be migrated
and shared with other translation memory solutions that also support this
standard.

How are a TKK and an Alchemy TM different?

A TTK is a bi-lingual file whereas an Alchemy desktop TM is a multi-
lingual file. You can the Clean Up Expert to consolidate many Project
TTKSs into a desktop TM file at the end of a localization project. This
provides a convenient and powerful mechanism for consolidating all
your translations into a single, highly portable, desktop translation
memory.
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Clean Up Expert

The Alchemy Clean Up Expert is used at the end of a translation
project to create translated target files and to consolidate bi-lingual
Project TTKs into a single Alchemy Translation Memory. This helps
centralize all translations into a single file and location, and makes it
easier to manage pre-translation and analysis of the next phase of a

translation project.
3 Clean Up Expert et |
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Since all translations are stored in a single .TM file, it can be shared with
other members of your translation team.

An Alchemy Translation Memory (.TM) can also be used with the
Analysis and Leverage Expert.
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What is a Job File?

A Job file is used by the Scheduler to run Alchemy Experts as
background tasks. Engineers and Project Managers that need to work
across several target languages simultaneously will use Job files to
schedule tasks that can be run using available computing resources on a
desktop machine.

6 In previous versions of Alchemy CATALYST, ezScript was
used to work across multiple Project TTKs. The Schedule
greatly simplifies this task and helps Project Managers and
Engineers achieve higher levels of task automation and
productivity.

For example, an Project Manager may be running several large project
analysis tasks in the background while he's working on checking the
quality of the translations using the Validate Expert.

A Job file consists of the following components:-

B  Project TTKS

A Job file can contain several Project TTK files. This makes it
very easy for Project Managers and Engineers to work across
multiple TTKS in several target languages.

B}  Source & Target Languages

Each Job file can have one source language and several target
languages defined.

)  Project Target Folder

This is the output folder that will be used to store the outputs
of each Job submitted to the Scheduler.

A Job file is stored as an XML document (.jobx) and can be created
using File->New Job or by any Content Management System (CMS)
that can work with XML documents.

If a Job file is used by an Alchemy Expert, it will be dispatched to the
Scheduler and run in the background of your computer using available
computer resources. This makes it possible to sequence and schedule
many tasks and have Alchemy CATALYST process them when
resources are available on your machine.
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What is the Scheduler?

The Scheduler panel is used to track the progress of jobs. It provides
constant progress updates for each Job that is being processed in the
background of your desktop PC. The scheduler can be halted or paused
at any time so that you can manage the computing resources allocated to
these background tasks.

EiSamplest HSep MO B Sep MO View repant
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What is a Task?

A task is created by selecting one of the Alchemy Experts and specifying
a Job File. All tasks are automatically scheduled and will run in the
background as computer resources become available. This means you
can continue to work in Alchemy CATALYST while these tasks are
processed by the Scheduler.

Scheduler Toolbar

The Scheduler can be controlled using the toolbar at the top right-hand
corner of the Scheduler Panel.

i } Click this button to run the next available task

() Click this button to pause all tasks in the Scheduler.

Click this button to delete a task from the Scheduler. It is not
x possible to delete a currently active task. To do this, select Pause
and then select the task to be deleted.
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What is the Alchemy SDK?

The Alchemy CATALYST SDK (Software Development Kit) 9.0 can
be used to develop Alchemy CATALYST extensions and applications.

The Alchemy SDK is a COM API library of programme functions that
allow precise control and access to the underlying data model and
technologies of Alchemy CATALYST.

For example, a developer can create custom code to check a segment for
proper use of trademarks and add this extension to the Alchemy Validate
Expert.

Alternatively, a developer may want to enumerate the content of a
Project TTK within Microsoft Excel so that a linguist can annotate
translations.

The Alchemy SDK comes as part of the Alchemy CATALYST:
Developer/PRO Edition.

6 Please Refer to the Alchemy SDK Programmer Reference
Guide for more information on this topic.
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What is ezScript?

ezScript™ is a Command Line Language that is used to automate
repetitive tasks. Using ezScript it is possible to integrate Alchemy
CATALYST within your language build system or content manage
system.

ezScript is a stateless programming language that is easy to learn and
ideally suited for Engineers that want to automate many of the manual
tasks associated with the localization process.

6 Please refer to the ezScript Programmers Reference Guide for
more information on this programming language. You'll find this
on the Help main menu.

What's the difference between ezScript and the Alchemy SDK?

The Alchemy CATALYST SDK (Abbreviation: Software Development
Kit) 9.0 can be used to develop Alchemy CATALYST extensions and
applications.

For example, a developer can create custom code to check a segment for
proper use of trademarks and add this extension to the Alchemy Validate
Expert.

Alternatively, a developer may want to enumerate the content of a
Project TTK within Microsoft Excel so that a linguist can annotate
translations.

The Alchemy SDK is a fully fledged COM API library of functions that
allow precise control and access to the underlying data model and
technologies of Alchemy CATALYST.

The Alchemy SDK comes as part of the Alchemy CATALYST :
Developer/PRO Edition.

6 Please Refer to the Alchemy SDK Programmer Reference
Guide for more information on this topic.
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Translator
Toolbar

The Translator Toolbar is designed to centralize all the functions that a
Translator needs to carry out their work efficiently and quickly. It
displays translation and glossary suggestions along with machine
generated translations.
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Description

1 Target Text Window

Translations are entered into this window. Inline tags are displayed
graphically and can be moved or deleted using a combination of the
keyboard and mouse. Incorrect words are highlighted with a red
underline and suggested spellings are displayed automatically in a
quick-pick dropdown list.

2  Source Text Window

This is the original source language text. This may contain red over-
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lines that indicate that a word is available in the glossary and is
displayed in the Glossary Reference window (4).

If a translation memory suggestion is located and displayed in the
main Reference window (3) this window may contain colored
markups to distinguish text that has been added, moved or deleted.
This should be used in conjunction with the % Fuzzy Match figure
to determine how good a suggested translation is.

3 TM Reference Window

This window displays Translation Memory matches as well as
Machine Translation suggestions.

4  Glossary Reference Window

This window displays Translation Memory matches as well as
Machine Translation suggestions.

5 Toolbar

This provides quick and easy shortcut access to many of the
features of the Translator Toolbar.

Accessing TM Suggestions

Using a combination of the ALT and extended keys, translation
suggestions can be displayed in the Translator Toolbar. These are
summarized below:-

Ins  Home PgUp
Translation Memory

Keys
= . = = Del End PgDn
EEEETEERT L ELE [ALT] +
N 6 ) ) .
. e N /e N i PP

4
Glossary Files .

& 00
[ALT) +

A
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TM Reference Pane

Suggested translations are displayed here. Suggestions can be either
identical or similar matches, often referred to as Fuzzy Matches. A
percentage (eg in the example below it's 95% similar) score is displayed
adjacent to each fuzzy match and several fuzzy matches may be
available for each original segment.
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Use the Next and Previous buttons to view different matches for the
current segment. The fuzzy value for the next and previous matches are
displayed underneath these buttons.

Identifying Differences in Fuzzy Matches

To help translators determine the differences between a suggestion fuzzy
match translation and the source segment they are currently working on,
Alchemy CATALYST will highlight these. The following mark-up
convention is used to highlight any of these changes:-

Highlight  Description TRADOS Equivalent

Underline Indicates the presence of new text between  Blue colored text
the source text and the text displayed in the
reference pane.

Double Indicates that additional words/phrases Grey colored text
Underline have been added to the new source

segment.
Strike- Indicates that words/phrases exist in both Yellow colored text
thru source and target but have been moved.
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Keywords

Keywords are used to prevent words or phrases from being translated
and included in word count analysis reports.

The default Keyword file is stored in your Public Folder. (e.g.
"\Users\Public\Alchemy Software\Catalyst 9.0" on Microsoft VISTA).

When a word or phrase is defined as a Keyword it will be displayed as a
placeable tag (highlighted with a blue underline) in the translators
toolbar.

EE Translator Toolbar

Validate Project

The Keyword is now excluded from word counts and analysis and can be
validated using the Validate Expert to ensure that it's not modified during
the translation process.

Defining Keywords

Keywords are defined using regular expressions and are displayed as
placeholders in the translator toolbar. These definitions can be saved in
the default Keyword file or a custom keyword filename. Some examples
of keywords are:-

Keyword Description
Definition

Alchemy Defines a keyword "Alchemy"

[0-9]+ Defines a keyword containing one or more digits. This is a
powerful and easy was to lock all numerical data in a project
and to exclude these from word count analysis reports. See
Customizing Word Count also for more information on this.

Copyright  Defines a keyword "Copyright"
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Applying Keywords to a Project file

This is referred to as Locking keywords. To lock keywords to a Project
TTK, use Tools->Keywords->Lock Keywords from the Alchemy main
menu. In the example above, the following segment would be displayed
as follows in the Translator Toolbar if these keywords were applied to it.

ECopyright (c) 2000 Alchemy Software Development. All Rights Reserved.

Each word that matches a keyword definition is displayed with a blue
underline and is locked and excluded from the translation process. It is
also not included in any Analysis reports.

Removing Keywords from a Project file

This is referred to as Unlocking keywords. Use Tools->Keywords-
>Unlock Keywords from the Alchemy main menu to permanently
remove keywords from a Project file.

Working with Placeables

Placeables or tags are found in XML and HTML based documents.
These are generally used to describe text emphasis marks such as bold,
underline, italic or hyperlinked text. Placeables are displayed using
graphical symbols; [ETRONG> denotes the start of an inline tag and
denotes the end of this tag.

Some inline tags may have a number of attributes associated with them.
In some cases these attributes may also need to be translated. Inline tags
that contain attributes have a plus symbol ([EPANE) displayed alongside
them. To edit these, right click it and select Edit Attributes.

Placeables can be moved using the mouse. Simply click on it and drag it
to its new location.
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Predictive Type

Alchemy ezType is a predictive-text technology that helps translators
work faster by monitoring what they are typing and auto-completing
words or phrases. It is language independent and works in both single
and double byte languages. It is integrated into the Translator Toolbar
and is used to accelerate the entry of source text and glossary terms
during the translations process.

Click on the & button on the Translator Toolbar to toggle ezType
on/off.

How does it work?

Alchemy CATALYST monitors the keystrokes of a translator while they
work. It compares these keystrokes to the glossary list, TM suggestion
and original source text is then scanned to see if a possible match
between both can be found. If a match is found, Alchemy CATALYST
will auto-complete the word/phrase for the translator.

A word/phrase that is being auto-completed is displayed as
U —ESOREESN This highlighted area of the word is the predictive-text
that Alchemy CATALYST is suggesting is the word/phrase required.

Recycle Translations

Recycle Translations is a advanced technology that scans the current
Project for translated segments and presents these to the translator for
selection in the Translator Toolbar,

This helps create higher consistency and quality in translating highly
repetitive content.

This ensures that every possible translation is presented to the translator
as they work, even though he may only have read-only access rights to a
shared or server based TM.

Use the PowerTranslate Toolbar and click on to toggle Recycle
Translations On/Off.
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Filters

Filters are used to organize the Project Workspace pane. For example,
it's possible to use a filter to display only untranslated strings, or strings
marked for review etc. In addition to this you can build your own filters.
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Filters can be selected from the Quickfind toolbar or from the Project
Navigator.

Finding Duplicates

Alchemy CATALYST has a special filter used to locate repeating
occurrences of segments in a project. This Duplicates Filter sorts the
content of the project or a section of it according to the number of
repeated occurrences of each string.
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Active Translation Memories

Only Active Translation Memories can be used to find and display
suggested translations in the Translator Toolbar. Several Translation
Memories can be active simultaneously and suggested translations from
these TMs will be displayed in the reference pane of the Translator
Toolbar. To open a Translation Memory and view translations:-

Click on Active TM tab at the bottom of the Translator Toolbar.
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Click #1 to add a new Translation Memory to the list of Active
Translation Memories. Select the type of TM required from the list on
the screen and locate it using the Browse button.

Concordance Searching

The Alchemy Concordance Manager provides a powerful mechanism
to search active Translation Memories for previous translations of a

word or phrase.
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Click on the Concordance panel to search active Translation Memories
for previous translations of phases or words.

Type the word project in the search entry control and click Go to start
the concordance search.
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Active Glossaries

Glossaries are used by professional translators to improve the
consistency of their work. Alchemy CATALYST works with a wide
range of desktop and server based glossary formats such as:-

e TBX
e Tab Delimited Files
e TRADOS MultiTerm
e TMX
Selecting a Glossary

To select a Glossary, go to Tools -> Options, and select Glossary from
the list provided.

e Click #1to open a new glossary and use it for terminology
lookup.

e Locate the glossary file on your desktop PC.
e Click OK to attach this glossary to Alchemy CATALYST.

An unlimited number of glossary files can be specified using this
method, and each time a term is found it will be displayed as a
translation suggestion in the reference window of the Translators
Toolbar.
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Finding Inconsistent Translations

An inconsistent translation is a string that does not match its entry in the
active glossary. For example, if the glossary contains the Japanese
translation #& T for the English word Exit, and this word is translated
differently in the project, Alchemy CATALYST can highlight this
inconsistency.

To check for translation inconsistencies, at least one active glossary file
must be configured. To learn how to configure a glossary file, please
refer to Configuring A Glossary.

To check for translation inconsistencies:
Select an item or group of items in the Project Navigator pane.

PowerTranslate - X
DEIRZI T oVEar - LIRS EY T

Glossary Consiskency Check

Click on the Glossary Consistency Check button located in the
PowerTranslate toolbar.

Any translation inconsistencies will be displayed in the Results Toolbar.
Double click on these error messages to locate them in the Project TTK.

Using Machine Translation

Use the [CTRL]+[ALT]+M key combination to generate a translation
using machine translation services. You can also click on the Machine

Translation button (g) on the PowerTranslate Toolbar.

Disabling Machine Translation Services

To disable Machine Translation Services for a Project TTK, click
Disable Machine Translation in Application options.
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Alchemy Project
Environment

The Alchemy project environment is a highly visual workspace that
allows Project Managers, Engineers, Testers and Translators work with
many file types.

FEFLY |
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At the core is a highly efficient Translation Memory technology that
provides accurate and precise re-use of previously translated materials.
In addition to this it contains Alchemy Expert technologies to help
automate many of the manual tasks inherent within the localization
workflow.
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Description

Project Navigator

The Project Navigator pane displays the content of the
project in an organized, hierarchical list. When a
software application is inserted into a project for
example, its individual components such as menus,
dialogs, strings and bitmaps are displayed in the Project
Navigator. These individual components are referred to
as project items.

Project Workspace

The Project Workspace pane is where project items are
displayed. The Project Workspace has several display
modes; String View, WYSIWYG View, Split-
Horizontal and Split-Vertical View Mode.

Translator Toolbar

The Translator Toolbar pane is where the items
displayed in the Project Navigator and Project
Workspace panes are actually translated.

TM Reference Pane

This pane is used to display suggested translations and
glossary terms. Please refer to Using Active Translation
Memories and Using Glossaries for more information
on how to configure this pane.

Concordance Pane

The Concordance pane is used to display the results of
concordance searching on Active Translation
Memories.
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Translator Toolbar

The Translator Toolbar brings together everything a professional
translator needs to work quickly, accurately and consistently. Translation
and glossary suggestions are displayed here and if a segment has no
translation suggestion available for it, the translator can use Machine
Translation to create one.
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# Description

1 Translated Text Window

Translations are entered into this window. Inline tags are displayed
graphically and can be moved, added or deleted using a
combination of the keystrokes and mouse. Incorrect words are
highlighted with a red underline along with glossary matches and
keywords.

2 Source Text Window

This is the original source language text. This may contain red
over-lines that indicate that a word is available in the glossary and
is displayed in the Glossary Reference window (4).

If a translation memory suggestion is located and displayed in the
main Reference window (3) this window may contain colored
markups to distinguish text that has been added, moved or deleted.
This should be used in conjunction with the % Fuzzy Match figure
to determine how good a suggested translation is.

3 TM Reference Window

This window displays Translation Memory matches as well as
Machine Translation suggestions.

4 Glossary Window

This window displays translation suggestions from glossary files.
You can also configure new glossary files by clicking Glossary
Source.
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TM Reference Window

Suggested translations from Active TMs are displayed here. Suggestions
can be either identical or similar matches, often referred to as Fuzzy
Matches. A percentage score is displayed adjacent to each fuzzy match
and several fuzzy matches may be available for each source segment.
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Use the Next and Previous buttons to view different matches for the
current segment. The fuzzy values for the next and previous matches are
displayed underneath these buttons.

Multiple translation suggestions can be displayed from several different
TMs. This helps achieve higher translation re-use during a project. The
'source' of the translation suggestion is displayed adjacent to it. In the
example above, the translation suggestion has comes from an Alchemy
desktop TM file.

Markup in Fuzzy Matches

To help translators determine the differences between a fuzzy match
translation and a source segment, Alchemy CATALYST will highlight
these using the following industry standard convention:-

Markup Description TRADOS
Equivalent
Underline Indicates the presence of new text between the Blue
source text and the text displayed in the colored
reference pane. text
Double Indicates that additional words/phrases have Grey
Underline been added to the new source segment. colored
text
Strike- Indicates that words/phrases exist in both Yellow
thru source and target but have been moved. colored
text
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Project Navigator

Use the Project Navigator to view the contents of Projects TTKs. It
displays the contents of projects in a hierarchical list that can be
configured in a number of different views.
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) G O8I B g 4B 2

Current Filters

It also provides a quick access toolbar
to Alchemy Experts, such as Leverage
and Validate.

The project that is displayed in the
Project Navigator is referred to as the
Active Project.

Folders can be used to group files
together. In the example below, all
online help files are stored in a folder
called Online Help Files.

To launch an Expert, click on its
quick-access link at the bottom of the
Project Navigator.

Select a filter by clicking on the radio-button adjacent to it. This filter
will affect the content of the Project Workspace window. For example, if
you select the filter Untranslated, only untranslated segments will be
displayed in the string list in the Workspace window.

All String Mode

Use All String Mode ([2]) to display all the strings of a Project TTK in
the Project Workspace. This is especially helpful when searching for
untranslated segments in a partially translated Project TTK.

Extended Attributes

Click on Extended Attributes (|E|) to set priorities and other extended
attributes for the content of a Project TTK.
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Project Workspace

The Project Workspace is used to display translated segments and
visual editors. You can also switch between active Project TTKs by
clicking on the tabs at the top of this window.

[ 'I'I'KltIkrD PowerTranslahe.]‘;V’D Magellan. ttk ] i
2 Look for: | http:/f Vl -3 I:| Look in:
2o || 5| Translated Original
(5] Untranslated Items
@ Alchemy CATALYST Basics Alchemy CATALYST Basics
& [ET>Achemy CATALYST [ET>Achemy CATALYST
Basics Basics
@ Alchemy CATALYST is a visual Alchemy CATALYST is a visual

localization environment. localization environment.
gk s,

R v VORI Y

QuickFind Toolbar

Use the QuickFind Toolbar to locate specific segments or to apply a
filter to the segments in the Project Workspace. Select a filter from the
Project Navigator or the drop-down list in the QuickFind Toolbar.

WYSIWYG Editors

The Project Workspace includes several highly visual editors for a
wide variety of file formats. They are automatically selected when an
item is selected in the Project Navigator.

A

—/'I::.[“]‘-r-‘,r._.I-.,T-f\r'-f«\r“'-_..

You can choose to work in a non-visual mode in any editor in Alchemy
CATALYST. This is referred to as String Mode.
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Scheduling Jobs

The Workspace window supports four different types of display
orientations. These can be selected using the Project Toolbar at the top of
the application window.

Display Mode

Description

String View

Visual View

Horizontal Split
View

Vertical Split
View

This displays only the strings in an organized list in
the workspace pane.

This displays project content in highly visual, context
rich editors.

Selects String View and WYSIWYG mode split on
horizontal axis.

Selects String View and WYSIWYG mode split on
vertical axis.
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Concordance

The Alchemy Concordance Manager provides a powerful mechanism
to search active Translation Memories for previous translations of a
word or phrase.

@ Concordance 2 x
- _l]
[ settings |
Search
V| Remove Oid Results @ Qrignal
Search current file Translated
| ®| Results

2 Search Term: “Interactive Ampersand Addition 1
E2 v (3 In&teractive Ampersand Addition

AUAIDTAHIT YRR BT HET)
v -JIn&teractive Ampersand Addition

AVBSET AT R E BT H(8T)
v [SInteractive Ampersand Addition

P EOIEN
| %" Sin&teractive Ampersand Addition

AESOT A NET U E BT B(8T)
I ¥ Elndteraciive Ampersand Addition

ABIDT AT ENT BET)
I ' i Interactive Ampersand Addition

Pt o

B i i e )

The Alchemy Concordance Manager will search any Active TM during
a lookup and display the results of this in the Concordance window.

Segment Information

The translation status and TM source of segments found during a
concordance lookup is displayed alongside it in the concordance
window. This provides helpful information to professional translators. In
the example above, segments have been located in both a Project TTK
and an Alchemy TM.

Searching a TRADOS TM

Alchemy CATALYST can perform a concordance lookup with
TRADOS TMW files or SDL TM servers. However the results will be
displayed in an external window and not in the Alchemy Concordance
window.
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Project Statistics

Use the Project Statistics window to view translation statistics about the
currently active Project TTK. These statistics can help in determining the
cost and schedule for a localization project.

~ eoE=r x
. ; s T e e
3 Ondins Help 2590 5% 1236 (47%) 123% 0 1364 (52%) 129 58
L3/ vortex Demotm 2580 =% 1236 (47%) 123% ] 1354 {52%) 12% £l
il (OGN i o ; o 3 :
21 ) B dalog_todlbarhim 51 =1 97 (38%) 7 0 154 (61%) 154 0
y - - o m . a5 = :
sy Basx_Steps for_a_Project 1954 1954 44 (48%) Eeal 0 1010(51%) 129 58 3
B SEMEEE A : B 5 s e 2 !
Column Description
Words Grand total of words in a Project TTK. This includes
locked segments, Keywords and duplicates.
Translatable Number of words that are translatable in a Project. While
segments that are locked and/or Keywords are not
included in this wordcount, duplicates segments are
individually included in this number.
Translated Number of words that are marked as Translated in a

For Review

Signed Off

Not Translated

Untranslated
Unique

Untranslated
Duplicates

Segments

Total Resources

Project TTK. This includes all For Review, Leveraged
and Signed-Off segments.

Number of words that are marked For Review in a
Project TTK.

Number of words that are marked as Signed-Off in a
Project TTK.

Number of words that are untranslated in a Project TTK.

Number of translatable words minus the total number of
duplicate words.

Word count of untranslated duplicate segments in that
Project TTK.

Number of segments in a Project TTK.

Number of resources (items) in a Project TTK
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Results Toolbar

Use the Results Toolbar to view report information about Project TTKs.
For example, the results of the Validation Expert are stored in the
Results Toolbar as are the results of the Comparison Expert.

|-_',-,m -] & x
Dxaleg - 1000

D-a-'u:-'.:l).]

s

g - 1000

ot

Different Results Views

The Results Toolbar has a number of views. These views are used by
many of the Alchemy Experts for status messages and error information.
To select a view click on View and highlight it from a list.

View Description

General This is the default view and progress messages from most Experts
are displayed in this view.

Advanced Find Progress messages from Advanced Find and Replace operations

and Replace are displayed in this view.

Todo List All Todo items and bookmarks are displayed in this view.

Comparison The results of the Visual Comparison Expert are displayed in this
view.

Inheritance This is used when working on .NET applications. This view will

display the inheritance information for winforms and controls. To
jump to related forms and controls, simply click on the inheritance
information and it will be located and displayed in the workspace
pane automatically.

Scheduler Output from a scheduled task is displayed in this view.
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Project Toolbar

The Project Toolbar is used to open or edit a project, insert a file,
import/export sections and define source and target languages.

From left to right, the project toolbar contains the following commands:

§ 00 s (= 5[] 1] [ gt - English ireland) « Frenth (France) -e@amusl

Button Description

New Click here to create a new Project TKK.

Open Click here to Open a file or Project TTK.

Save Clicking here to save the active project.

Delete Click this option to remove the currently
highlighted item from a Project TTK. This can
be a file or folder.

QuickFind Click here to use QuickFind to locate a

Insert File

Extract
File

Insert
Files &
Folders

Create
Folder

Delete
Folder

Language

Help

String
View

segment in a Project TTK.

Use this feature to locate a file and insert it
into a Project TTK.

Click here to extract the translated version of a
file.

Use this feature to insert both files and folders
into a Project TTK. The folder structure will
be preserved during this operation.

Click here to create a new Folder.

Click here to delete a Folder.

Sets the source and target languages of the
active project.

Launch the Alchemy CATALYST Help
System.

This displays only the strings in an organized
list in the workspace pane.
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Visual
View

Horizontal
Split View

Vertical
Split View

Options

This displays project content in highly visual,
context rich editors.

Selects String View and WYSIWYG mode
split on horizontal axis.

Selects String View and WYSIWYG mode
split on vertical axis.

Select this to go to the User Profile dialog box.

Layout Manager Toolbar

The Layout Manager Toolbar is used to automatically re-size dialog
boxes. This toolbar is only visible in the dialog editor.

DN o fJE

From left to right, the toolbar contains the following commands:

Button

Description

Previous dialog
Next dialog
Layout dialog

Layout dialog
(without border)

Revert layout

View original

Moves to previous dialog box in your active project
Advances to the next dialog box in your active project

Automatically re-sizes every control, plus the dialog
frame until everything fits.

Automatically re-sizes every control, while maintaining
the dialog frame, until everything fits.

Reverts to the previous layout of the dialog.

Toggles between original and translated view of a dialog.
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Dialog Toolbar

The Dialog Toolbar is used to align dialog controls (individually or in
groups), zoom in and out of dialogs, view original language versions of
dialog boxes and improve the overall productivity of localization
professional.

STl b g o 8668286

From left to right, the toolbar contains the following commands:

Button Description

Left align Left align a group of controls.
Right align Right align a group of controls.
Top align Top align a group of controls.

Bottom align

Center Vert.

Center Horiz.

Bottom align a group of controls.
Align a group of controls along the vertical axis.

Align a group of controls along the horizontal axis.

Same height Make the height of a group of controls match.
Same width Make the width of a group of controls match.
Same size Make the width and height of controls match.
Flip dialog Flip all controls in a dialog box so that they appear correctly in

View original

bidirectional languages such as Arabic or Hebrew.

Toggles between original and translated view of a dialog.

Zoom In Zoom into a dialog box. This makes all controls and fonts bigger,
and easier to read on the screen.

Zoom Out Zoom out of a dialog box. This makes all controls and fonts
smaller.

Default Cancels the effect of zooming and returns the dialog box to its

Zoom original size.

Clipped text Detect any clipped text in a dialog box.

Duplicate Detect any duplicate hotkeys in a dialog box.

hotkeys

Overlapping Detect any overlapping controls in a dialog box.

controls
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Alchemy Experts are designed to automate repetitive tasks frequently
found within the localization workflow. Many of them can be used with
the Scheduler and run as background tasks on a desktop PC.
Additionally, almost all can be programmed using ezScript and/or the

Alchemy Software Development Kit.

Name

Description

Leverage
Expert

Validate
Expert

Pseudo-
Translate
Expert

Clean Up
Expert

Layout
Manager
Expert

Comparison
Expert

Analysis
Expert

This Expert is used to maximize the re-use of translation and
to pre-translate new content with previous translations.

Use this expert to automatically detect errors commonly
introduced during the translation and engineering process.

This expert is used by developers to verify that their
software, web sites or online help systems can be easily
translated. They also use it to verify that no hard-coded
strings exist in software applications.

This Expert is used to consolidate Project TTK files into an
Alchemy desktop TM file.

Layout Manager automatically creates localized layouts for
translated software applications.

Determining the scope of change is vital in planning
localization projects. This expert identifies these differences,
allowing a project manager to see the impact of these on
project costs and schedule.

Use this expert to calculate the amount of translation re-use
that can be achieved using Translations Memories and to
predict the incremental costs of a localization project.
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Launching Experts

Many Experts can operate on the currently active project or on a folder
of files. This makes them very powerful and ideal for large scale
automation of the localization process.

“=. Leverage Expert

. .\| Validate Expert

'E‘T‘— Pseudo Translate Expert

Layout Manager

©RE Yy 2

For example, it is possible to use the Validate Expert to validate an entire
folder of files in one simple operation. Alternatively, if you want to
embed some of the functionality of these Experts into a build system or a
workflow, the ezScript programming language can be used.

6 For more information on ezScript, please refer to ezScript
Programmer's Reference Guide.

The available Experts are always displayed at the bottom of the
Navigator pane. To select an Expert simply click one of these buttons
and the relevant Expert will launch itself automatically.

Experts can operate on single items in a project, groups of non-
contiguous items, the entire project or folders.

You can select multiple items from the Navigator pane using the
[CTRL] and [Shift] key combinations. This means that Experts can
process non-contiguous objects from your projects.
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Using Job Files

A Job file can be used with all experts. This works in conjunction with
the scheduler and runs these as background tasks on a desktop PC.

Leverage

Active object:

(@ Job File:
C:'\Mirvana 2.0 -SampleMy Sample Job Flle.jobx  « E]

C:\Samples'\Demo-WPF. ttk
C:\Samples\LayoutManager. ttk
C:\Samples\MyProject - Copy. ttk
C:\Samples\MyProject. ttk

Job Location: C:'\Mirvana 2.0 -Sample’,

Target Languages: [Chinese (Simplified, PRC)

The progress of a Job can be tracked using the Alchemy Scheduler. This
is a popup window available within the Alchemy Project Environment.
Reports

Many of the Alchemy Experts produce reports. These reports are XLIFF
based and can be viewed in any internet browser.

Generate Report
FEilename: |
Select report type Repaort Options 4
) Compact Attach .xsl stylesheet 1
(%) Verbose View report immediately 1
St P e ST ¢’#‘.‘ i R, J

6 The Analysis Expert creates a text-based fuzzy match report and
not the normal XLIFF report type. This is eye-readable and easy
to work with in creating project cost estimates and schedules.
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Leverage Expert

Alchemy CATALYST provides powerful Translation Memory lookup
technology called ezMatch, which allows localization professionals to
reuse previous translations. The Leverage Expert is designed to
maximize the amount of translations that can be reused from multiple
file formats.

[ General | optians | Object Types | Repart
. - z

Leverage
Active object:
@ Job File:

Ci\Schedhier Wew Job.jobx v (o) [ Bt | [ mew...

C:\Samples\Demo-WFF. ttk
€:\Samples MyProject.

Job Location: C:\scheduler|

Target Languages: | French (France) )

Choose TM Sources
Iu [# C\Samples\Transmem.tm

o =[x

The Leverage Expert applies translations to Project TTKs and can be

used to pre-translate files prior to dispatching them to a professional
translator.

One of the most unique and powerful features of ezMatch technology is
its ability to not only leverage translations, but also to leverage
coordinate and layout information. This means that all translation and
localization engineering work can be reused from project to project.

6 The Leverage Expert works with many TM formats such as PPF,
TTK, TMX, TMX, TXML, TXT, SDL TM Server.
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What is Fuzzy Match?

Alchemy CATALYST generally searches for exact matches. Fuzzy
matching is a technique used to find translations that are similar rather
than identical to the original source segment. Alchemy CATALYST uses
the fuzzy match technique to search the translation memory for matches
that are similar as well as matches that are identical to the search text.

In practice, this means that the current source segment is matched
against those already present in the translation memory. Alchemy
CATALYST calculates the degree of similarity between the current
source segment and matching source segments from the translation
memory. The degree of similarity is expressed as a percentage value.
The segment with the highest match value (a 100% match value
indicates an identical match) is selected as best match. Other less similar
matches are presented as well. You can paste any of the suggested
matches into your translation. Differences between the current source
segment and fuzzy matches from the translation memory are highlighted,
making it easier to edit the matches you choose.

Alchemy CATALYST allows you to set the percentage fuzzy match
value to a minimum acceptable level. Segments from the translation
memory must achieve this value before they can qualify as fuzzy
matches. All segments below this minimum value are treated as no
match segments.
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Options

There are many options that can be configured to maximize the re-use of
translation and to ensure the highest possible quality of lookup during a
Leverage operation.

Software Specific Options

Software Spadfic Options

[ Exclude Coordinates from Leverage

[C) Exclude Text from Leverage

[¥] Add missing ampersands (&) to beginning of strings

[CExpand x~coordinates by |15 | T %if dialog match not found
Option Description
Exclude Coordinates Select this option if coordinates are to be ignored
from Leverage during a leverage operation.
Exclude Text from Select this option if you want to ignore translation
Leverage during a leverage operation. The net effect of this is to

just leverage the coordinate information froma TM .

Add missing This is a useful option when you are using TMs that
ampersands do not have any hotkeys defined. Selecting this option

will insert a hotkey during the Leverage operation to
all strings that are missing hotkeys.

Expand x-coordinate This option is normally used in conjunction with

by.... Exclude Coordinates from Leverage and it forces
cach control to expand by a set amount to
accommodate new translation.
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Generic Options

Generic Leverage Options

[Leverage From same ohject bype anly [lonly change status if text changes
Leverage Locks Retain Signed OFf status

Leverage Memos

Option Description

Leverage from  Select this option if you want translations leveraged

same object from identical objects in your TM. This means that if

type only the object types don't match, the translation will not be
re-used.

Leverage Similar to the above option, except locking information

Locks will also be copied over during a leverage operation.

Leverage Select this option if you require any existing memos to

Memos be copied across to the new TTK project file during the
leverage operation.

Only change Select this option if you want text assigned the status

status if text 'For Review' only when it differs from the original

changes source. For example, the button 'OK' is the same in

English and in German, so selecting this option will not
mark this control as translated.

Retain Signed- By default all text that is copied during a leverage

off status operation is assigned the status ‘Leveraged, For
Review’. However, if the copied translation is already
marked as ‘Signed Off’, selecting this option will
inherit this status in your newly leveraged TTK project
file.
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Advanced Options
Advanced Options — —
[ use Fuzzy Matching at _| % hest L
] utput TM Hits to File: [
Options Description

Use Fuzzy Matching at  This is the level at which a Translation Unit will be
excluded from the search results of a Fuzzy match. For
example, if you set the threshold at 75%, then all
translations units that score less than 75% of similarity
are excluded from the fuzzy search results.

Best __ fuzzy matches The option limits the number of matches that the
ezMatch™ technology will locate and present to the
translator.

Output TM Hits to a file  Select this option if you want all your fuzzy matches
stored in an external TMX file. This file can then be
dispatched to your external translator so that they can
review all fuzzy matches themselves.

This switch is useful if an Engineer wants to pre-

translate only 100% exact matches and leave all fuzzy
match translations to a qualified translator.

Interactive: Displays Selecting this option will pause the leverage operation
strings when a fuzzy each time a fuzzy translation match is found allowing
match is found the translator to select the most appropriate from a list.
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Validate Expert

This expert is used to automate the detection of errors commonly
introduced during the localization process. The Validate Expert also has
a companion technology, the Runtime Validate Expert, which validates
software applications in runtime mode.

General | Options: | Object Types | Report|

Active object{s):
@ Job File:

Ct\Scheduler Plew Job.jobx v [l

C:\Sampies\Deme-WPF .tk
C:\SampiesMyPraject. itk

Job Location: Crischedulery,

Target Languages: |French (Franee)

P S S S
e

The Validate Expert will automatically detect errors such as duplicate
hotkeys, overlapping controls, inconsistent translations etc. It displays
error messages in the Results Toolbar pane.

Locating Errors

To locate an error in Project TTK, double-click each error message in the
Results Bar. Alchemy CATALYST will open the relevant Project TTK
automatically and position the cursor alongside the segment containing
this error.
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Configuration Options

Configuration
| Mark Yalidation Errors
[ Ignore Locked segments [ Ignore error if present in source

[ Ignore Signed Off segments [ Ignore Untranslated segments

Option Description

Ignore Locked Select this option to exclude locked strings from
segments any validation checks.

Ignore Signed Off Select this option to skip segments that have a
segments Signed-Off translation’s status.

Ignore error if Select this option to omit errors that exist in both
present in source the translated and original source files.

Mark Validation Use this option to 'mark’ segments that contain
Errors

errors with a o4 symbol in the string list.

Ignore Untranslated  Select this option to skip Untranslated segments.
segments

The Validate Expert is used to perform a wide range of checks against
an individual or group of Project TTKs. The results of these checks are
stored in the Results Toolbar or in an external report file.

ﬂ Use the Alchemy CATALYST 9.0 SDK to develop
custom Validation Tests that enhance or replace the
default tests provided.
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Validation Tests

There over thirty different types of validation tests supported by the
Validate Expert. You can also extend the Validation Expert by building
custom validators using the Alchemy SDK.

Language Validation Tests

Test

Description

Mismatched empty
string

Inconsistent
Keywords Check
Incorrect spelling

Untranslated text
marked For Review
or Signed Off
Glossary Consistency
Check

Generates an error if the original string is empty
and the translated string is not. This test is useful
when validating your TTK project files for
over/under translations.

This validation test verifies that keywords are
identical in both the source and target segments.
Spell checks your translation. Alchemy
CATALYST comes with several spelling
dictionaries. You can select your spelling
dictionary by going to the General Options
dialog.

This Validation test verifies that a segment that
has a translation status of For Review or Signed
Off has been translated.

This validation test verifies that each segment
that contains glossary terms are translated
according to the Active Glossary file(s).

Software Layout Tests
Test Description
Clipped Text in Dialog This validation test verifies that translated text

Duplicate hotkeys in
dialogs

Duplicate hotkeys in
menus

Duplicate accelerators

Validate dialogs for
overlapping controls

displays without any clipping on a dialog box.

This validation test verifies that each hotkey in a
dialog is unique.
This validation test verifies that each hotkey in a
menu is unique.

This validation test verifies that menu accelerators are
unique.

This validation test verifies that no controls overlap
each other in a dialog box.
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Runtime Validation Expert

This expert is used to automate the detection of common localization
errors that can be introduced during software localization projects. It
differs from the Validate Expert in that it validates the application while
it is running on the desktop.

This expert works only on Win32 applications, embedding a
6 special debug segment into the application that is used to track
the location of each error detected.

59



Getting started quickly

Pseudo-Translate Expert

This expert is used to simulate the effects of translation on the project
files. It does this by substituting vowel characters in the source files with
diacritical or accented characters.

6 Select Tools - Pseudo Translate Expert (or click on the
relevant button on the Experts Toolbar) to launch the
Pseudo Translate Expert.

General | Options | Object Types

W L MEXPE e e (M

Pseudo Translate

(D) Active object(s): My Project Release 8.1 {
@) Job File:

C:\scheduleriew Job . jobx - E] 1

1

C:\samples\Demo-WPRF. ttk
C:\Samples\MyProject. tk ‘

Job Location: C:\scheduler,
Target Languages: [Frenrh (France) i
S . .
“ramemal

The Pseudo Translate Expert can be used carly in the product
development cycle to determine if an application can be translated easily.
It may be used, for example, to determine if an application crashes if a
series of strings are translated; or if a series of strings will fit on a dialog
panel if they expand as a result of the translation process.

The Pseudo Translate Expert can be configured to simulate a number of
different languages. The Chinese Han character set can be selected for
example, and applied to the project to determine if these characters are
supported correctly.
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Conversion Characters

Conyersion characters
@pregefined: | Chinese Semulation (a6 b-F B ik o114 o8O hE P8 HEKE £ v
O Qustom:
Option Description
Conversion Select this option to replace characters in the source text with
Characters accented characters. Select from a range of predefined
character maps or create new character maps using the
Custom text box. A custom Character Map consists of a pair
of characters delimited by a comma. Each pair of characters
denotes the character to be searched for and the character to
be replaced with. The character map EE for example, will
replace each upper case E with E.
Custom Define a custom set here.
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Custom Sets

Custom sets can be used to modify the standard Pseudo-Translate
behavior in Alchemy CATALYST. Click on the Custom radio button
and create a string with the following syntax.

Pattern Search Replace Description
For With

a-a A A Every instance of ‘a’ will be replaced with ‘&’

B-B% B B & Every instance of ‘B’ will be replaced with ‘B
5%°. This adds a Chinese character to your
string, while maintaining the readability of the
original string. E.g. “Build” becomes “B %%
uild”.

T-Text T Text Every instance of ‘T’ becomes ‘Text’

Help- Help NoHelp  This pair demonstrates string to string

NoHelp substitution. So if the string ‘Help’ is found, it
is replaced by the longer ‘NoHelp’ string.

Exceptions

If the replacement changes a hotkey value or a control character, the
substitution will not be performed. For example:-

Sample  Pattern Result Performed Reason

String

File F-XXX XXXile Yes

&File F-XXX &File No Hotkey would be changed

Y%os s-S %s filename No Formatted string would

filename break

%s %s-%S %S filename Yes A substitution for exact

filename format character is
requested
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Layout Manager

Alchemy Layout Manager™ is award winning, state-of-the-art enterprise
software that combines the power and flexibility of Alchemy
CATALYST with a robust solution for improving the productivity of
localization engineers. It automatically creates localized layouts for
software applications ensuring that simultaneous availability of
translated applications is a certainty.

How Alchemy Layout Manager works?

Alchemy Layout Manager creates new layouts for localized applications
by analyzing the layout of the original application user interfaces. These
computer generated layouts require less testing and less engineering
helping to reduce project cycle times. This ensures that applications are
released to international markets quicker.

Based on award winning and patented technology, generated layouts
share the same spatial relationships of the original application, however
are re-sized and re-shaped to accommodate translations. This unique
technology ensures that generated layouts conform to corporate interface
guidelines and standards, ensuring consistency of corporate image and
branding worldwide.

The accuracy of this layout analysis is so high that even dialogs with
overlapping controls can be processed quickly and accurately.

== o
o Jo-p Cobe
E 2o ETE
D () Do o)
Before After

Once a localized layout is generated, it is then tested by Alchemy Layout
Manager to determine how good the layout is. Any generated layouts
that have a high probability of layout problems will be flagged and
suitable error messages displayed in the Results Toolbar.
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This ensures that localization engineers can process thousands of dialogs
in a single session and only have to check dialogs that have a high
probability of error.

In extensive industry trials, Alchemy Layout Manager scored an average
accuracy of 97% in generating good layouts, helping our clients achieve
SimShip as part of their localization strategy.

Options

The following default options are available to configure Layout
Manager.

General | Options

Allow Dialog resizing heeshold Vs 1
] Group Boxes distance 78 3
Alignment sensitivity (0-4) 2
Controls distance T4
Dislog Right Threshold 8 I
Groupboxes Right Threshold __8- !
j
_— = g, s =
Option Description
Allow Dialog  Deselect this option if you want to maintain the width
resizing and height of dialogs. Alchemy Layout Manager will

move all elements within the Dialog frame and try to
accommodate your layout without re-sizing the dialog

frame.
Alignment This options is used to set/reset the sensitivity of
sensitivity Layout Manager when creating relationships between

rows and columns of controls. You can enter a value
between 0 and 4.

Restore Select this option to reset Alchemy Layout Manager

Defaults with its original default settings and values.

Group Box This is the minimum distance between a group box and

distance adjacent objects. Setting this value will define how
close items can be to each other in a generated layout.

Controls This is the minimum distance between a control and

distance adjacent objects. Setting this value will define how

close items can be to each other in a generated layout.
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Dialog Right  This is the minimum distance between a control and

Threshold right border of a dialog frame. Setting this value will
define how close items can be placed to the edge of a
dialog.

Group Box This is the minimum distance between a group box and

Right adjacent objects. Setting this value will define how

Threshold close items can be placed to the edge of a group box.

Toolbar

The Alchemy Layout Manager Toolbar is designed to allow fast access
to Alchemy Layout Manager and to facilitate high speed layout of dialog

panels.

< H@@@Ei

From left to right, the buttons in the Layout Manager Toolbar are:-

Button Description

Move to previous item Click this button to move to the previous
item in a Project TTK

Move to next item Click this button to move to the next item
in a Project TTK

Auto-Layout Dialog Click this button to automatically layout a

Box dialog form. This layout will resize all
objects within a form including the dialog
itself.

Auto-Layout Dialog Click this button to automatically layout a

box without resizing dialog form. This layout will resize each

frame object within a form but will not resize the
dialog outer frame.

Revert Layout Reverts all or selected controls back to

their original position.

Toggle Original View Toggles between the original and

translated forms.
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Errors

Alchemy Layout Manager™ analyses computer generated layout to
determine bad or ambiguous layouts. These warning and errors are
stored in the Results Toolbar.

| \samples Layoutianager . ttk

[ 3 boaded using appropriat
! Ly Performing PeeudoTransiation. ..

| 4 Firished Object Pseudo Translate,

| iLaying out Dislogs...

| 4 Disdog - 20050

i(a:naaog - 20050

(€ iaiog - 20050

i'g;:moq-znsm

| user's setfingz. —

To go directly to a dialog with a high probability of layout problems,
double-click the error message and Alchemy CATALYST will load and
display the location of the dialog box in your workspace window.
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Comparison Expert

The Comparison Expert is used to determine the scope of changes
between two Project TTK files. It can be used to detect new, deleted or
modified files stored in Project TTKs. The Comparison Expert can
process any file type once it is stored in a Project TTK. Even proprietary
file formats can be processed by the Comparison Expert so long as an
ezParse rule or custom editor exists for that particular format.
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Use the Project Comparison pane to view the results of the Alchemy
Comparison Expert. This panel is located alongside the Navigator pane
in the Alchemy Project Environment.

The Project Comparison pane can be organized into a summary report

by clicking the 3 button. This will organize the contents of the pane
into items that are new, modified and removed. This makes it easier to
detect changes in Project TTKSs.

The Project Workspace pane will split into two windows and display
the differences between both objects. The differences will be highlighted
using a color scheme and a bounding rectangle will be drawn around
each point of difference.

6 To see a text view of the changes only, click on E (Text
View) from the main Project Toolbar.
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Options

Use the Options tab to define the types of comparisons to be carried out

by the Comparison Expert.

Usa Comparison Expert to detect:

[#] Dsfferences between Project TTHs

[#] additions to Project TTK
[#] beletions from Project TTK

Option

Description

Similarities between
Project TTKs

Differences between
Project TTK

Additions to Project TTK

Deletions from Project
TTK

Select this option to detect only similar objects
between both TTKs. This creates a report
detailing only unchanged items between both
version of a Project TTK.

Select this option to detect the differences
between two revisions of a Project TTK file.

Select this option to detect new items in your
currently active Project TTK or items that you
have selected in the Project Navigator pane.

Select this option to detect items that have been
deleted from two revisions of a Project TTK.
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Analysis Expert

The Analysis Expert analyses sources files and Project TTKs by
comparing them to translation memories and calculating the number of
segment matches. A word count report is created that can be used by
project managers to determine a schedule and costs of a translation
project.

Analysis Expert =

Analysis Type |

(0 ™ analysi (Usng UT)
@ TM Analysis (Scheduler) I
() Project Snapshot

The Snapshot Analysis outputs the content of the current project to an diff I
report, The report contains the original & translated segments as well as
ward count analysis according to the translation status,

o) o ) o)

Interactive Analysis

Select Interactive Analysis to specify a number of Project
TTKs and relevant TMs and to determine how much
translation can be leveraged. This report creates an analysis
based on the amount of fuzzy translations that can be re-
used from a variety of TMs. This report can be used to
determine the cost of translating a Project TTK.

Scheduled Analysis

Select Scheduled Analysis if you want to create several
reports simultaneously. By selecting this option, you will
be asked to specify a Job File which will then be
dispatched to the Scheduler for processing.

Project Snapshot

Select Project Snapshot to create a report containing a
listing of all translation segments in a Project TTK. This
report will also contain a summary wordcount analysis.
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Interactive Analysis

This analyses one or more projects by comparing them to a translation
memory to calculate the number of segment matches between the
projects and the Translation Memory. The progress of this analysis can
be tracked on the screen as each segment is analyzed against the list of

Translations Memories.

{3 Anatysis Bxpert ===
EAPER —— t
Fies to Analyse
) C:\Samgles - Copy\MyProject.tk =2
| B 7 c\samples - Copy\Demo-WPF.ttk lﬂ
| word Count |
| Project Languages
Source Language:  Engish (ireland) e E———
Targetlanguage:  Japanese (Japan) Change
Chagse TM Sources
8 ¥ c\Samples\ Transmem.ttk I=5
T ) C2\Samples\Mutti-transmem.tm %]
i
4
Analysis Log File
Ci'UsersiPubliclalchemy Software'Catalyst 3.0\snafyssiog. bet vl
— :
[ oc ][ comel ][ hen

A summary word count report is created at the end of this process, which
can be used by project managers to determine a schedule and costs of a

translation project.

An analysis log file is also created which itemizes the results of each
source or Project TKK being analyzed.
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The following progress screen will be displayed during an Interactive

Analysis operation.

(B Analysis Expen

| =% Analysis

Analyss Expert
£ C\Samples - Copy\MyProject.ttk
C:\Samples - Copy'\Demao-WPF ttk

=
ol .X_F!ER'_I_"' p— 1

118

This dialog displays the progress of every file as it goes through the
Analysis process. At the bottom of the screen a summary report is
provided that breaks the analysis down across several fuzzy-match

categories.
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Report Columns

The following columns and data are used in every Analysis Report.

Category

Description

Perfect Match

Duplicates
(Untranslated)

100%

95%-99%

Locked

Previously for
Review

Previously
Signed Off

Total

This is the highest possible match from a TM. It arises
when the source segment is identical to the text in the TM
and the context in which the source segment is used is also
matched in the TM.

This is the count of the number of untranslated duplicates
segments in your Project TTKs. Only the first occurrence
of a duplicated segment is included in this figure.

This is a match when the source segment is an identical
match to text in a TM but it's context may differ.
Generally, these segments will need to be reviewed and
their translations verify by a senior translator or editor.

This is a range of non-identical matches that have been
found in the TM. The higher the percentage value the more
accurate the match in the TM.

This is the count of segments that are in the Project TTKs
but are locked. They are not included in the Total words or
any other fuzzy match count.

This is the count of words that are already translated in the
Project TTKs and are marked for Review. Generally, these
segments will need to be reviewed and their translations
verify by a senior translator or editor.

This is the count of words that are already translated in the
Project TTKSs and are marked 'Signed Off".

This is the Total word count of translatable segments in
the Project TTKs.
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Scheduled Analysis

Scheduled Analysis uses a Job File and analyses one or more projects
by comparing them to multiple translation memories to calculate the
number of segment identical and fuzzy matches.

Ansdysis Exprt —— TE i |

| General | Dptions [ Object Types [ Analysis

Analysis®
P
Leverage
() Active object:  Cisko
@ Job File:

Ci\Scheduler\Sample Thres Languages.jobx + o) Lt

Ci\samples - Copy MyProject, tt

Ci\Scheduer| !
Target Languages: |Chinese (Smpified, PRC) -
|
Chocse TM Scurces
[EZ ¥ C:\Samples\Transmem. ik ﬂ
Tu [ €\Samples\Multi-transmem.tm I
|
T
( CI

Tracking Progress

You can track the progress of the Analysis Expert using the Scheduler
main window.

o Scheduler 2 @ B
Task CStatus Seurce TTK | Target Folder | Seurce Language| Target Language | Sterted at Finished at Report
lanadys Running... CASchedulert 24 5ep 20101532

Anlysis Running...  Ci\Samples - Copy\MiyProject it CAScheduler, s de-DE

Analysis Running..  CASamples - Copy\MyProjectitk CASchedules oS (]

Analysis Running...  C:\Samples - Copy\MyProject.itic CAScheduler, en-Us zh-CH

- ——

When the analysis completed, click on the View Report option in the
Scheduler main window to see the analysis results.
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This Report displays the analysis results of every file as it goes through
the Analysis process. At the bottom a summary report is provided that
breaks the analysis down across several fuzzy-match categories.

Please refer to Report Columns for more details on the format of this
report.
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Project Snapshot Analysis

Use this report to view wordcount and segments information for a
Project TTK. This report consists of two sections; Summary and
Verbose.

Summary Report

Resowrce type Vords Tranplatable Translated Mot Translaied For Reveersy Signed O
Entire Report 25045 25040 1E4T 702 18347 Q
Resource File 28045 o4 18347 &T02 18347 ]
A o a o o ] ]
REGIZTRY ] L] 0 0 L] L]
TEXT o L] o o 1] [:]
TYPELIB o a o o -] -]
TPETWD o ] 0 ] L] ]
Etituap 1] L] 0 0 [ [

L] armn ELp] 2059 mn 2049 1]

Dialog 4585 4595 328 1267 az ]
StringTabl 16058 12TE2 278 12782 ]

Use this report to see a top-level wordcount analysis of a Project TTK
based on the status of each segment. This report is based on XLIFF and
can be viewed in any internet browser.

Verbose Report

& project Tite- /[ Catalystoxe/ = Dalog : 20048 - R IO — F 4204

Words T E Tranal liod Tr d  For Review  Ssgned 08 Rescwrces  Segments
5 3B IS(100%) O 0 %) k-] o 5

Source Tangat
1] Floating Cells el i m e P
EREAE Floaling Cells el i m B P |
58110 Allow call o Baal other calls BOITo0-F AR EETRoTD
51911 Allow cell % be fooded by clher cells Bl e ERETEITS

J b LA DA O DA T S T D
Hobe: Certain Cell Types (8.9 Combobomas) don = IR S
B5535 llow Noiling c#ll3 3nd ignore the Above Seflings TR TR VR,

P, W‘ %

This report contains a detailed listing of every segment in a Project TTK.
It displays item word counts and individual segments in a columnar
report. This report is based on XLIFF and is viewable in any internet
browser.
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QuickShip Expert

This expert provides a convenient mechanism to distribute TTK project
files to translators. It does this by creating a self-expanding executable
that can contain several project TTK files, glossary files and other
project information. These are referred to as QuickShip Bundles.

TTHKs | Glossaries | Other files | Memao | OLrtert|
E i i
' ﬁ..,@lﬁl'aﬁl? o)
| L g:\( e

TTKfiles:
C:\SamplesDemo-WPF itk
C:‘Samples'LayoutManager itk
C:\vSamples'MyProject ttk

As these bundles are compressed they can be conveniently attached to
emails or placed on FTP servers. When a translator attempts to open a
bundle, it will automatically decompress the files contained in the bundle
so they can be translated.

Translators do not need to have a full license of Alchemy CATALYST
in order to work on QuickShip Bundles. They can use Alchemy
CATALYST: Translator/LITE Edition.

6 To download a personal copy of Alchemy CATALYST
Translator/LITE, please click here.
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Glossaries

Use the Glossary Tab to add glossary files to a Translation bundle. You
can add as many glossary files as required.

TTKs | Glossares | Otherfiles | Memo | Output

=% QuickShip =
— Em— : /
W LEXPERT, e
i, .

Glossary files:

C:\Samplesglossary tho Add..

C:“Samplesglossary - Copy thexml

When these files are extracted, Alchemy CATALYST Translator/Lite will be
automatically configured to use the first two of these glossaries.

These glossaries are automatically activated in Alchemy CATALYST
when extracted from the QuickShip bundle.

TM & Other Files

Use this tab to add any number of Translation Memories and
miscellaneous files to a QuickShip Bundle.

TTKs Iﬁossanes Otherfiles | Memo | Output

"+ QuickShip .
0 L MEXPERT. e £
[ e |

Other files:
C:\Samples"\ExpenseltStandalone exe
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Memo

The Memo will be displayed when a translator opens a Translation
Bundle. This can be sued to give project instructions or other helpful

information to your translators as they prepare to work on your Project
TTKs.

. - QuickShip.
3 < ;-_-::m
T X P ERT, — ﬂ
This memo will be displayed when this Quick Ship bundle file is opened:
Hey Cristiano,

Flease translate the screen shots highlighted
inthe TTKfirst and send back.

Thanks,

Tony

Output

Use this tab to specify a name for a QuickShip Translation Bundle.
Translations bundles are executable files so will always have a .EXE file
extension.

TTKs |[—‘Jossa1es|[!.herﬁles|Memo Output

This wizard creates a seff-extracting executable which can be easily distibuted. The contents can be

extracted by double-clicking, and edited using Alchemy CATALYST or Alchemy CATALYST
Translator/Lite.

Self-extracting executable:
C:\Samples‘toCristiano exe - @l

Use the Browse button to navigate to the location of an existing

QuickShip Translation Bundle. Press OK to create your Translation
Bundle.
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QuickShip Translation Bundles are used to distribute project files to
translators. Translation Bundles may contain several Project TTKs,
glossary files and other miscellancous files that form part of a

localization project.

QuickShip Translation Bundles are compressed and are stored in a self-
extracting application. To open it and start working on its content,
simply download it to your desktop and double-click on its filename.

[ Quickship Sel

Output | Contents | About |

Estract contents to folder:

[EAS amples\Catalyst_Repot

Created 19/03/2007 By torwod

e

= &

Crstiano,

Thanks a milbon,

Arudeew

Please enzure that Enda has the screen shots before next Monday for the box shots,

1'@

Extiact Cancel

Viewing Contents

Click the Contents tab to view the contents of a translation Bundle.

Extracting Files

To extract the contents of a Translation Bundle, use the navigator button
and go to your working folder. Then press Extract. This will extract all
the files from a Translation Bundle and copy them to your working
folder. You can now localize these files using Alchemy CATALYST

Translator/LITE Edition.

Any memo attached to the QuickShip Bundle is also
displayed on this tab. Use this memo to provide useful

instructions to the translation team.
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Clean Up Expert

Use the Clean Up Expert to create target files and to create or update
translation memories.. The Clean Up Expert is used to create Alchemy
Desktop TMs but also works with a wide range of other industry TMs.

Clean Up -

XPERT

B8 7] C:\Template TM Flicien-jph Transmem.ttk

B [¥#] C:\Template TM Flle\en-de\transmem.ttk gl
. x|
B3 ¥l c\Template TM Flie\en-zh\transmem.ttk

=
x]
LogFile
Ci\Users\Public\Alchemy Software\Catayst 9.0\deanuplog. txt - “_j i
{

[ox J[ const J[ v |

Files to clean up

Select the files that are to be processed by the Clean Up Expert.

Click on Browse and use the File Open dialog box to locate and
select files. To delete files from the list, highlight them using the
mouse and click on Delete.

Extract Files

Select this option to extract files from a project file and create
translated target files.

TMs to Update

Select the TM that is to be created or updated by the Clean Up
Expert. This can be an Alchemy desktop TM or other industry TMs.

Log File

The Log File contains an audit trail of the outcome of each Clean
Up operation. You can specify a new filename here or use the one
provided. The results of the latest Clean Up operation are always
appended to the end of the log file
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Saving to GlobalLink TXML Files

Use the File Export command to create GlobalLink compatible TXML
files. This is helpful if you want to create a TM that can be used by
GlobalLink or Wordfast translation memory or workflow products.

Saving TRADOS Compatible Files

Use the File Export command to create TRADOS compatible TTX files.
This can be helpful if clients wish to receive TRADOS TTX files at the
end of a translation project.
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Alignment

Translation Alignment creates a Translation Memory from translated
materials. Alignment technology determines which parts of the source
and target language files are similar, and aligns them, creating high

quality translation memories.
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Smart Alignment Technology: Alchemy CATALYST uses
smart alignment technology to examine the structure and
meta-data in a file, and uses this to create an automatically
aligned Translation Memory. This can later be modified by the
localization professional to fine tune or modify any
misaligned translations.

One-to-Many Relationships: The alignment technology
supports one-to-many and many-to-one relationships between
source and target translations. This makes it possible to align
languages like English and Japanese.

Files Supported: Over 170 different file types are currently
supported by the Alchemy CATALYST alignment
technology, so virtually any desktop, mobile or online content
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can be aligned using this powerful and sophisticated
technology.

e Custom File Alignment: Due to the flexibility of the
alignment technology, even proprietary file formats that have
an ezParse rule can be automatically aligned in one session.

e Batch Alignments: Alchemy CATALYST can align
individual files or folders containing files. This makes it ideal
for working with large numbers of files.

Alignment Modes

The Alchemy CATALYST alignment technology can align any file type
that can be stored in a Project TTK. Even proprietary files can be aligned
by Alchemy CATALYST so long as an ezParse rule exists for them.

Alignment operates in two modes:-

e Interactive Alignment: Select this option if a file is to be
manually aligned using the interactive alignment environment.

e Automatic Alignment: Select this option if files are to be
automatically aligned. Since Alchemy CATALYST uses an
advanced parsing technology for each file type, most files can
be automatically aligned to a high level of accuracy.
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Alignment Environment

The alignment environment is divided into two main panels. The source
file is displayed in the left panel with the target file is displayed in the
right panel.

vatap T
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To manually align segments

Use the mouse to manually align two segments, click on Al adjacent to
the source segment and while holding down the mouse button, drag
and drop it onto the matching target segment.

A line will be displayed between both segments indicating the
alignment ( Iﬁ]—\ﬂ).

6 To remove the alignment for a segment, right-click on & and
select Remove Alignment.
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Other Options

e Sync Scrolling: Select this option to scroll both panels at the
same time. This is useful when manually aligning segments using
the mouse.

o Next Match: Use this button to let the Alchemy CATALYST
alignment technology determine the next possible alignment point
in your source and target files

e Alternative Match: Use this button to let the Alchemy
CATALYST alignment technology determine an alternative
match for the current source segment.

e Undo Match: Click this button to undo the most recent segment
alignment.

o Align All: Select this item to automatically align each source and
target segment.

e Start Over: Select this option to cancel all previous alignments
and re-start the alignment process.

To automatically align segments

Alchemy CATALYST can automatically align most file types based on
an analysis of its structure. Click on Next Match to allow Alchemy
CATALYST calculate the alignment of each segment automatically.

To automatically align all file types and bypass the Alignment Editor, go
to Tools - Options and select Automatic Alignment from the
Alignment options dialog.
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Browse button, 12
CATALYST Software Developer’s Kit,
5
Clean Up Expert, 80

Comparison Expert, 48, 67, 68
Comparison Results, 67
Comparison Tab, 68
Concordance window, 32
Configuring, 34
Machine, 34
consistency, 34
Coordinates-Leveraged, 31
CSV, 32, 33
CTRL, 49, 59
Specifying, 59
Custom Editor, 67
custom editor exists, 67
Custom Pseudo Patterns, 62
Custom Set, 62
Custom text, 61
customised, 69
Customizing, 28, 34
Keywords, 28
refer, 34
Customizing Keywords, 28
Cycles, 60, 63
Databases, 15
decompile, 5
Default, 31
Use, 31
Defense, 5
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Define, 28, 62
Defining Keywords, 28
denote, 16
item’s, 16
Department, 5
including, 5
Deselect, 50
Deselect All, 50
designing, 5
Software Developer’s Kit, 5
Desktop, 82
Detail, 15, 50, 68, 75
Detecting Errors, 66
Detects, 66
Determine, 5, 31, 48, 57, 60, 61, 63, 66,
67,69, 70, 82, 84
Alchemy Layout Manager, 63
Leverage Engine, 70
TM Analysis Report, 69
Dialog Panels, 15, 28
Dialogs, 15, 28, 31, 50, 57, 59, 60, 61,
63, 65, 66, 82, 84
disassemble, 5
Product, 5
display, 15, 28, 30, 84
Displayed As, 15, 16, 28, 30
Drag, 84
Drop, 84
Duplicate Accelerators, 57
Duplicate hotkeys, 57
Duplicates Filter, 31
Duplicates/Repetitions, 31, 70
Finding, 31
Dynamic Link Library, 59
Editor, 5, 15, 16, 31, 84
exception, 57, 62
Exclude Coordinates, 53
Exit, 34
Expansion, 61
Expert Bar, 51, 67
expert provides, 76
expert use, 48

Index

Experts, 11, 12, 48, 49, 50, 51, 53, 56,
59, 60, 61, 67, 69, 70, 76, 77, 80
Launching, 49
Extract, 79
ezMatch™, 15, 51, 53
ezMatch™ Fuzzy, 53
ezParse, 67, 82, 83
ezParse rule, 67, 82, 83
ezParse rule exists, 83
ezScript, 24, 48
ezScript Programmer's Reference Guide,
48
ezType, 30
ezType On/Off, 30
Switching, 30
Finding, 31
Duplicates/Repetitions, 31
Finding Duplicates/Repetitions, 31
Folders, 82
Fuzzy Matching, 70
General License Agreement, 5
General Options dialog, 57
Generate Report, 50
Generic, 15, 53
German, 53
Idiom WorldServer, 51
inconsistencies, 34
Inconsistent hotkey, 57
Inconsistent lead/trail, 57
Incorrect Spelling, 57
Interactive Analysis, 70
Job File, 21
Keyword, 28
layout, 63, 65, 66
Layout Manager, 63, 66
Layout Manager Toolbar, 65
Leverage, 53
Leverage Expert, 51
Machine, 34
Configuring, 34
main menu, 28
main.css, 69
Matches, 15, 28, 30, 84
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matches during pre-translation, 15
Max Lengths, 15
meta-data, 70, 82
misaligned translations, 82
Mismatched Empty Strings, 57
missing, 53
hotkeys, 53
mis-translation, 48, 50
Modes, 11, 12, 31
Modify, 5, 62, 82
Product, 5
Monitor, 30
mouse, 82, 84
name, 15
Navigator, 34, 49, 53, 67

new, 32, 33, 48, 53, 61, 63, 67, 68, 77

new project, 77

new Project TTK, 77
QuickShip, 77

New translations, 32, 53

new TTK, 53

Next, 15, 84

Next Match, 84

NoHelp, 62

NoHelp’ string, 62

number, 70, 82
words/segments, 70

Object Tab, 50

OCT 1988, 5

OK’, 53

One-to-Many Relationships, 82

online, 5, 11, 15, 82

online helps, 15, 48

Open, 32, 33, 76, 82

Opening, 31, 79

optimised, 15

Options, 28, 33, 53, 61, 82, 84

Options Tab, 53, 61, 68, 70

Oracle, 15

organise, 67

organised, 67

organising, 31

organize work, 31

Using Filters, 31
Original, 15, 16, 30, 62
other, 77
Other Files Tab, 77
over/under, 57
Overlapping, 57

Controls, 57
Overview, 22, 25,31, 48
Pages, 15
panels/windows, 15
Paragraph Alignment, 82, 84
part, 5, 82

Product, 5

Software, 5

Software Application Product, 5
Perfect Match, 70
PerfectMatch, 70
perform, 53, 62

Fuzzy, 53
Performance, 5
personally-identifiable, 11
popup, 82
popup menu, 82
Post-Text, 61
PowerTranslate toolbar, 31, 32, 34
predictive-text, 30
Press, 82
Press OK, 33, 82
Pre-Text, 61
Preview, 61

Use, 61
product activation, 11, 12
Product Certificate, 11, 12

Requesting, 12
Product Tour, 31, 32, 33, 34
Productivity, 63
Products, 5, 11

copy, 5

disassemble, 5

Modify, 5

part, 5

rights, 5

run, 5
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Transfer, 5
use, 5
program, 5, 12
Activating, 12
programme, 48, 67
Project, 11, 15, 16, 28, 31, 32, 34, 48,
49, 50, 51, 53, 56, 57, 59, 60, 61,
63, 65, 67, 68, 69, 70, 75, 76, 77,
79, 82, 83
Checking, 34
Project Navigator, 16, 31, 68, 82
Project Results Bar, 57
Project Snapshot, 69, 75
Project Snapshot Report, 69, 75
create, 69
Project Title, 82
Project Toolbar, 67
Project TTKs, 11, 15, 16, 28, 32, 51, 65,
67, 68, 69, 70, 75,76, 77, 79, 82,
83
Project Workspace, 31, 67
Properties, 15
protects, 28
provides, 15
Pseudo, 60, 61, 62
launch, 60
Pseudo Translate, 60, 61
Pseudo Translate Expert, 60, 61
Pseudo Translation, 61
Pseudo-Translate, 28, 62
Pseudo-Translate Expert, 28, 48, 60
Quickfind, 31
Quickly, 63
QuickShip, 76, 77, 79
new Project TTK, 77
QuickShip Bundle, 76, 77, 79
QuickShip Expert, 48, 76, 77
QuickShip Translation Bundle, 79
Recycle Translations, 30
Red, 15, 67
refer, 5, 12, 15, 28, 34, 48, 70, 82
Alchemy, 5
Customizing, 34

Index

ezScript Programmer's Reference
Guide, 48
Finding, 70
What, 12
Reference, 15, 32
reference during, 15
translation, 15
Reference window, 15, 33
Regression Script, 57
Regular Expressions, 28
Relationships, 82
release, 63
Removes, 28
Removing Keywords, 28
Repeat Translation button, 31
select, 31
Replace, 62
Replace With, 62
Report, 28, 50
Report Tab, 50
report.xsl, 69
representations, 5
Republic, 5
Ireland, 5
requesting, 12
Product Certificate, 12
respect, 5
Software Developer’s Kit, 5
results, 53, 62, 67
Fuzzy, 53
Results Bar, 56
Results Toolbar, 34, 63, 66
Retain Signed-off, 53
Revert Layout, 65
Review, 16
Right Panel, 84
rights, 5, 82, 84
Product, 5
Root, 82
run, 5
Product, 5
Runtime Validate, 59
Runtime Validate Expert, 59
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Runtime Validation, 56, 59
s-%S, 62
Sample Keyword File, 28
Samples’, 5
Scheduled Analysis, 73
select All, 50
Select Step, 12
Select Tools-QuickShip Expert, 77
Server, 82
set, 15, 53, 62
Advanced Options, 53
Generic, 53
Software Specific Options, 53
set/reset, 16
Settings, 83
Signed Off, 16
Signed Off’, 53
SignedOft, 31
SimShip, 63
Smart Alignment Technology, 82
SmartPhone Canvas Areas, 15
softlifting, 11
Software, 5, 15, 57
part, 5
Software Application Product, 5
part, 5
Software Developer’s Kit, 5
designing, 5
respect, 5
Software Specific Options, 53
Setting, 53
Software Validation Test, 57
Software Validation Tests, 57
Source, 15, 30, 82, 84
Source Language, 15, 84
Source Text, 15, 30
SPECIAL, 5
specifier’s change, 57
Specifying, 59
CTRL, 59
s-S, 62
Start Over, 84
Started, 82, 84

state-of-the-art, 63
Strings, 15, 62
structure, 82, 84
sub-ttk, 16
Summary, 75
Summary Report, 70, 75
Super TMs, 15
support, 15, 82
Switching, 30
ezType On/Off, 30
Sync Scrolling, 84
T, 62
tags, 15
Target, 15, 30, 82, 84
Target Language, 15, 30, 82, 84
Templates, 5
TERM, 5
Text, 5, 15, 28, 48, 50, 51, 53, 57, 61,
62, 67,70
text string, 61
Text View, 67
Text’, 62
TM, 15, 32, 48, 51, 53, 69, 70
TM Analysis, 69, 70
TM Analysis Report, 69, 70
determine, 69
TM Hits, 53
file, 53
TM Hits file, 53
TM ie, 70
TMs, 15, 32, 48, 69
types, 32
TMW, 69
TMX, 32, 33, 48, 51, 53, 69
including, 33
TMX Document, 51
TMX file, 53
Toggle Original View, 65
toolbar, 15
Tools, 33, 51, 67, 84
TRADOS, 15, 33
TRADOS MultiTerm, 33
select, 33
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TRADOS MultiTerm iX file, 33
TRADOS TMW, 32
TRADOS Translators Workbench, 15,
51
Trait, 15
Transfer, 5
Product, 5
Translate, 15, 28, 82
Translated Text Window, 15
Translation Alignment, 82
Translation Bundle, 79
Translation Editor, 16
Translation Memory, 15, 19, 32,48, 51,
53, 69, 70, 82
group, 70
Translation Status, 16
Translation Status Information, 16
Translation Toolkit, 15
Translation Units, 53
Translations, 15, 16, 19, 28, 30, 32, 34,
82
reference during, 15
Translator, 15, 25, 28, 30
translator eCatalog, 30
Translator Toolbar, 15, 16, 25, 28, 30,
31,32,33
Translator Toolbar contains, 15
Translator/Lite Edition, 76
TRAODS Translators Workbench files,
48,51, 53
T-Text, 62
TTK Project, 16
TTKs, 16, 48, 51, 53, 57, 68, 76
Type, 15, 30, 32, 82, 84
TMs, 32
US.,5
Undo, 84
United States Government, 5
Unlocking, 28
Update, 48

Index

Update Expert, 48
USAGE OF TRADE, 5
Use, 5, 12, 15, 28, 30, 31, 61, 69, 82, 84
Activate, 12
Analysis, 69
Browse button, 12
Default, 31
Preview, 61
Product, 5
SDK, 5
Use Fuzzy Matching, 53
use Tools->Keywords->Lock
Keywords, 28
Use Tools->Keywords->Unlock
Keywords, 28
used, 15, 28, 30, 62
Using, 11, 12, 15, 28, 30, 31, 32, 33, 34,
48, 49, 51, 53, 57, 61, 67, 69, 79,
82, 83, 84
Using Active Translation Memories, 32
Using Concordance, 32
Using Concordance searching, 32
Using concordane, 32
Using concordane searching, 32
using ezMatch, 51
Using ezType Technology, 30
Using Filters, 31
organize work, 31
Using Filters1, 31
Using glossaries, 33
using Translations Memories, 48
using XLIFF, 69
Validate, 12, 48, 50, 56, 57, 59
ID, 12
Validate Expert, 48, 50, 56, 57, 59
Validation, 57
Validation Tests, 57
Verbose Report, 75
WholeWordFalse, 28
Word Count, 28
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